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Navigating in This Document

This Polaroid electronic document uses the Adobe Portable Document Format (PDF)
and its associated Acrobat Reader software. You should familiarize yourself with the
controls of the Acrobat reader. Access Help...Reader Online Guide...Viewing PDF
Documents...Navigating Pages for more information.

Polaroid electronic documents provide additional navigation tools at the top of the
screen. The icons have the following meanings:

Click @ to go to the table of contents.

Click to return to the previous page.
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Click @ to display these help pages.
Click @ to open the index.
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DMC 2 Camera Features

The Polaroid DMC 2 Digital Microscope Camera captures high-quality digital color
images from light microscopes and other optical instruments. The camera uses a 2-
million-pixel, 1lmm CCD (charge coupled device) to capture 14-bit linear RGB
images. It transfers these images in seconds to an IBM PC or Power Macintosh com-
patible computer in TIFF format with 1600x1200 or 800x600 pixels. On IBM PC com-
patible systems, an additional image size of 400x300 is available.

Next
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Using the software provided with the camera, you can:

Display a color viewfinder image on your computer screen.

Choose resolution, exposure, sensitivity, color temperature, and other options.
Automatically adjust exposure.

Manually adjust color balance, brightness, contrast and sharpness.

Verify focus digitally.

Add a calibrated scale to the image.

Add a title or other text to the image.

Transfer the image to your image-editing application or hard drive.

Capture a rapid sequence of images and select one for transfer to your computer.

Note: The DMC 2 software is compatible with DMC 2 and DMC Ie cameras.

Next 10
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The camera has a SCSI connection requiring no frame-grabber or other special hard-
ware or software. (The camera requires a SCSI host adapter, usually built into Macin-
tosh computers. SCSI host adapters can also be easily added to PC-compatible
computers.)

Compatible with standard .63, 1:1 or larger c-mount adapters, the camera attaches
easily to microscopes for most types of transmitted-light and reflected-light micros-

copy.

Multiple DMC 2 cameras can be connected in a SCSI chain to a single computer simul-
taneously for capturing images from multiple instruments without moving the cam-
era or reconnecting cables.

The camera also features a tripod mount, x-sync connection and remote shutter con-
nection for use with standard c-mount lenses on a copystand or tripod.

Detailed camera specifications

11
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Taking Pictures

Typical Picture-Taking Sequence

0O N & 1 A W N =

Turn on the camera.

Start the DMC 2 software.
Frame and focus the preview.
Choose a capture area
Choose color or grayscale preview. 13 Verify sharp focus digitally.
Rotate the image.

Zoom the preview.

Set exposure.

9 Set sensitivity.
10 Select color temperature.
11 Select image type.

12 Select image size.

14 Capture the image.
15 Enhance the image.
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Turning the Camera On
1
2

Turn off the computer.

Turn the camera power switch to on (1).

Power switch (on=1)

Verify that the green and yellow LEDs are on, indicating AC and termination
power are on.

I~ _ GreenLED
Yellow LED

1

Turn on the computer.
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Starting the DMC 2 Software

Macintosh Windows
Double-click Polaroid DMC 2. 1 Select Programs from the Start menu.
The main DMC 2 window appears. 2 Point to Polaroid Digital Microscope

Camera 2 and select Polaroid DMC 2.
The main DMC 2 window appears.

If more than one DMC camera is connected to the computer, you must select the cam-
era to be used in this session. To select a camera, see Selecting a DMC Camera.

14
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Selecting a DMC Camera

If more than one DMC camera is connected to the computer, use these steps to select
the camera to be used in the current session:

Macintosh Windows

1 Click the Preferences button in 1 Click Set Preferences on the Tools

the main DMC 2 window. menu.
2 Click Choose a DMC 2 in the 2 Click the Cameras tab.

DMC 2 Preferences box. 3 Click the SCSI address of the camera
3 Choose the SCSI address of the to be used.

camera to be used. 4 Click OK.

4 Click OK to activate the camera.

5 Click Save to close the DMC 2
Preferences box.

15
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Framing and Focusing the Preview

1 View the subject through the microscope eyepiece.

2 Adjust subject position, focus and lighting according to the microscope instruc-
tions.

3 If your microscope requires, manually switch the light path to the camera.

If a viewfinder image is not visible in the DMC 2 software main window, click the
Preview button.

Note: If clicking Preview does not display an image, you may need to adjust expo-
sure or sensitivity before continuing.

Exposure adjustment instructions.

Sensitivity adjustment instructions.

16
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Choosing a Capture Area

You can capture the entire DMC frame or a smaller, selected area.

To capture an area smaller than the DMC frame:

1 Adjust exposure to obtain an acceptable image on the Viewfinder Display tab of
the main DMC 2 window.

Click the Region of Interest Selection tab.

Select the size of the frame to be captured (3/4 or 1/2 frame) from the Capture
Area list.

A box defining the selected capture area appears on the image.

4 Position the capture area as desired by dragging it.

Next 17
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5 Click the Viewfinder Display tab to view only the capture area. The values avail-
able in the Image Size box correspond to the capture area you selected.

6 Continue with the picture-taking sequence.

18
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Choosing Color or Grayscale Preview

You can view the preview image in the DMC 2 main window in either color or gray-
scale. A color preview provides a more accurate representation of the final image,
while a grayscale preview refreshes faster.

To view a color preview image, select Color in the main DMC 2 window. To view a
grayscale preview image, deselect Color.

19
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Rotating the Image

To correct picture orientation, you can rotate the preview image 180 degrees
| by clicking the rotate button.

When you rotate the preview image, the final image is also rotated.

20
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Enlarging the Preview

You can enlarge the view of the preview image for focusing and closely inspecting
detail while framing. Enlarging the view does not affect the final image.

To enlarge the preview image:

1 Click the image to display the zoom and focus box.
2 Drag the zoom and focus box to the area of interest.

3 To zoom in, click | To zoom out, click ﬂ

21
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Setting Exposure Automatically

1 If you have not done so, calibrate automatic exposure for the current lighting and
specimen conditions. See Calibrating Auto Exposure.

2 Click the Auto button in the main DMC 2 window.

3 Wait a few seconds for the DMC 2 software to optimize the exposure.

22
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Calibrating Auto Exposure

1 Manually set exposure to the optimum position for the current setup. See Setting
Exposure Manually.

Click Calibrate Auto Exposure on the Tools menu.

Click the Set button in the Auto Exposure Calibration box.

23
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Setting Exposure Manually

Drag the Exposure slider right or left to adjust the camera shutter speed for brighten-
ing or darkening the image.

Range: 20 milliseconds (far left) to 8 seconds (far right).

24
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Setting Sensitivity

Choose a sensitivity (camera gain) setting from the Sensitivity list:
+ Low (ISO 25 equivalent)

+ Medium (ISO 50 equivalent)

+ High (ISO 100 equivalent).

The default setting is Medium (ISO 50 equivalent).

25
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Selecting Color Temperature

You can select one of the standard color temperatures to match your lighting:

+ Tungsten (3200K)

+ Daylight (5500K)

These color temperatures are appropriate for many lighting situations, but best

results are often obtained by creating and using a custom color temperature. This cus-
tom temperature appears as Custom in the Color Temperature list.

See Creating a Custom Color Temperature.

26
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Creating a Custom Color Temperature Setting

If the standard color temperature settings are inappropriate for your lighting, you can
create a custom color temperature setting based on the actual lighting.

To create a custom color temperature:

Macintosh Windows

1 Select Calibrate Custom Color Tem- 1 Click Calibrate Custom Color Tem-
perature from the Color Temp popup perature on the Tools menu.
mend. 2 Obtain a properly exposed and

2 Obtain a properly exposed and focused image in the DMC 2 preview
focused image in the DMC 2 preview window.
window.

3 Move the specimen to view a clear
3 Move the specimen to view a clear area of the slide.
area of the slide.

Next 27
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Creating a Custom Color Temperature Setting (continued)

Macintosh

Windows

4 Click Calibrate.

5 Wait for the Calibrate Color Tempera-
ture box to close.

6 To use the custom setting, select Cus-
tom from the Color Temp popup
menu.

4 Click Begin.

5 Wait for the Calibrate Custom Color
Temperature box to close.

6 To use the custom setting, select Cus-
tom from the Color Temperature
box.

28
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Selecting Image Type

You can select one of these image types for your final image from the Image Type box:
* 48-Bit Color (68.7 billion colors)
* 24-Bit Color (16.7 million colors)
+ 16-Bit Grayscale (65,000 gray shades)
+ 8-Bit Grayscale (256 gray shades)
The image type you choose affects the size of the image file. See Image File Sizes.
Note: Before saving images as 48-bit color or 16-bit grayscale, verify that other appli-

cations you intend to use support TIFF images in those formats. For example, Adobe
Photoshop version 5 supports 48-bit color images, but earlier versions do not.

29
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Selecting Image Size

Choose a final-image size from the Image Size box:

+ 1600 x 1200 pixels

+ 800 x 600 pixels

* 400 x 300 pixels (Windows systems only)

These sizes are available if your selected region of interest includes the entire frame. If

your region of interest is smaller, the available image sizes correspond to the size of
the selected region.

Larger image sizes usually improve image quality, but they also increase the image file
size and time required to transfer the final image from the camera to your computer.
See Image File Sizes.

30
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Image File Sizes

The size of the saved TIFF image depends on image type and size, as shown in the fol-
lowing table. (File sizes are approximate.)

Image Size
(Pixels) 48-Bit Color 24-Bit Color 16-Bit Grayscale 8-Bit Grayscale
1600 x 1200 11,300 kbyte 5,650 kbyte 3,800 kbyte 1,900 kbyte
800 x 600 2,900 kbyte 1,400 kbyte 1,000 kbyte 500 kbyte
400 x 300 700 kbyte 350 kbyte 240 kbyte 120 kbyte
(Windows
only)
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Verifying Sharp Focus Digitally

If necessary, you can fine-tune your image focus digitally with the DMC 2 software:

1

2
3
4

Click the image to display the zoom and focus box.
Drag the zoom and focus box to the area of interest.

Zoom into the area of interest by clicking EI
Click Focus Tool on the Tools menu.
The Focus Tool box appears.

Adjust the microscope focus knob until the two colored indicator bars are farthest
to the right.

The red bar indicates the maximum sharpness achieved so far. The other bar indi-
cates the current sharpness.

Close the Focus Tool box by clicking the Close button in the upper right corner.

32
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Capturing the Image

After you have selected the capture settings in the DMC 2 main window, you are ready
to capture the image and transfer it to the computer.

You have the following three options for capturing the image:
* Capture the image, enhance it with DMC 2 software, then save it as a TIFF file.
* Capture and save the image immediately as a TIFF file.

* Capture and transfer the image to a plug-in compatible application (Macintosh) or
Capture and transfer to a TWAIN-compatible application (Windows).

33
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Capturing and Enhancing with DMC 2 Software

Use this procedure to capture the image currently displayed in the DMC 2 main win-
dow for enhancement with DMC 2 software:

1 Click Capture & Enhance to capture the image, transfer it to computer memory,
and display it in the DMC 2 Enhance window.

2 Use the controls in the Enhance window to enhance the image characteristics, add
a text label, or add a calibrated micron marker.

Instructions for enhancing the image

Next 34
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3 Do one of the following:

Macintosh Windows

+ Save the image to disk by clicking = Save the image to disk by click-
Save Image (not available when —— ing the Save button.
running the DMC 2 plug-in).

| Transfer the image to a TWAIN

+ Transfer the image to a plug-in compatible application by click-

compatible application by clicking ing the Transfer button (avail-

Transfer Image (available only able only when running the

when running the DMC 2 plug-in). DMC 2 TWAIN source within the
application).

35
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Capturing and Saving Immediately to Disk

To capture the image and save it to disk without further enhancement:

1

Click the Capture & Save button.

Note: On Macintosh systems, this option is available only when running the DMC
2 software. When running the DMC 2 plug-in within another application, click
Capture & Transfer. Then save the image within the other application.

Choose a folder and filename for the image.

Click Save.

36
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Capturing and Transferring to Another Application (Macintosh)

Note: This option is available only if you are running the DMC 2 plug-in within the
other application. It is not an option if you are running the DMC 2 program.

To capture the image and display it in the application, click the Capture & Transfer
button and wait for the image to appear in your application.

After the image appears, you can edit, print or save it according to instructions pro-
vided with the application.

37
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Capturing and Transferring to Another Application (Windows)

Use these steps if you want to transfer the captured image immediately to another
image-processing or image-analysis program. The procedure you use depends on
whether you opened the DMC 2 program from the Windows Start menu or you
opened the DMC TWAIN software by selecting Acquire from an application's File
menu.

If you opened the DMC 2 program from the Windows Start menu:

1 In the DMC 2 main window, click Set Preferences on the Tools menu.
2 Click the General tab.

3 Click the Launch External Application box to enable it.

4

In the External Application Path box, type the path and name of the program file
to which you want to transfer the DMC images. You can also click the Browse but-
ton and select the program file.

Next 38
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5 Click OK.

When you click Capture & Save or the save button in the DMC 2 program, the
image appears in the selected application for further enhancement and saving.

If you are running the TWAIN version of DMC 2 software:

If you are in the DMC 2 main window, click Capture & Transfer. Wait for the image to
appear in your program.

If you are in the DMC 2 Enhance window or the Full Image window, click the transfer

button @l Wait for the image to appear in your program.

After the image appears in your program, you can edit, print or save it according to
instructions provided with the program.

39
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Capturing a Rapid Sequence

The DMC camera and software allows you to capture a rapid sequence of images in
the camera memory. After the images are stored, you can select one of the captured
images for transfer to the DMC 2 Enhance window or for saving immediately.

To capture a rapid sequence:

1 Set up the camera and obtain a properly exposed image in the DMC 2 main
window.
Connect the remote trigger cable to the camera.

Click the Rapid Fire button to display the Thumbnail Gallery.

Press the remote trigger button to capture an image and display its thumbnail in
the Thumbnail Gallery.

Next 40
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Repeat step 4 as needed to capture and display additional thumbnails until the
camera buffer is full.

Note: Change the Rapid Fire setting on the General tab of the Set Preferences box
to stop capturing images when the buffer is full or to begin overwriting the first
images captured.

Right-click a thumbnail you want to transfer.
A shortcut menu appears.
Click Image Output Size and select an image size.

To display the image in the Enhance window for image enhancement before sav-
ing, right-click the thumbnail again and click Enhance. Then adjust color, bright-
ness, gamma, etc., as usual and save the image.

To save the image immediately, right-click the thumbnail and click Save.

4]
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Printing the Image

To print the current image from the DMC 2 Enhance window:

Macintosh Windows

Select Print from the File menu. =, | Click the print button to open
your printer dialog box. Choose
the appropriate printer settings
and click OK.

The image prints at 300 dpi and sized to fill the page.

Note: To print at different resolutions or sizes, save the image and open it with an
image-editing application such as Adobe Photoshop.

42
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Enhancing the Image with DMC 2 Software

After you capture an image by clicking Capture & Enhance in the DMC 2 main win-
dow, the captured image is stored in memory and displayed in the DMC 2 Enhance
window. Before printing, saving or transferring this image to another application, you
can apply the following enhancements:

* Automatically adjust color balance

* Adjust color balance by selecting a point
that should be white

* Adjust color balance by selecting a point
that should be neutral gray

* Adjust color balance by selecting a point
that should be black

* Manually adjust color balance
* Manually adjust dark levels

Manually adjust brightness
Adjust gamma

View a histogram

Adjust sharpness

Reduce grain in long exposures
Add a label

Add a calibrated micron marker
Save and reuse program settings

43
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Automatically Adjusting Color Balance

ot | To have the DMC 2 program analyze the current image and automatically set
the color sliders to their optimum position, click the automatic balance but-
ton.

This feature is not recommended for fluorescent imaging.

44
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Adjusting Color Balance by Selecting a Whitepoint

7]

To adjust overall color balance by identifying a whitepoint in the picture, click
the white eyedropper button. Then click on an area of the picture that should
be pure white.

The area you clicked becomes white, and all other colors in the image are
adjusted accordingly.

You may need to repeat the procedure to achieve an optimum white balance.

45
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Adjusting Color Balance by Selecting a Neutral Gray Point

Z]

To adjust overall color balance by identifying a neutral gray point in the pic-
ture, click the gray eyedropper button. Then click on an area of the picture
that should be neutral gray, such as a metallic object, concrete, gray brick, or a
shadow falling on a white object.

The area you clicked becomes neutral gray, and all other colors in the image
are adjusted accordingly.
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Adjusting Color Balance by Selecting a Blackpoint

7 | To adjust overall color balance by identifying a blackpoint in the picture, click
L the black eyedropper button. Then click on an area of the picture that should
be pure black.

The area you clicked becomes black, and all other colors in the image are
adjusted accordingly

47
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Manually Adjusting Color Balance

Drag the three Color sliders left or right to adjust color balance.

The effect of your settings appears in the preview image to the left.
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Manually Adjusting Dark Levels

Drag the Dark Levels slider left or right to decrease or increase dark levels.

The effect of your settings appears in the preview image to the left.
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Manually Adjusting Brightness

Drag the Brightness slider right or left to increase or decrease brightness.

The effect of your setting appears in the preview image to the left.
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Adjusting Gamma

Drag the Gamma slider right or left to increase or decrease gamma (the apparent con-
trast between the highlights and the shadows).

The effect of your setting appears in the preview image to the left.
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Viewing a Histogram

Use the histogram display to judge the distribution of brightness values in the current
image. The horizontal axis represents all possible brightness values in the image (0-
255) and the vertical scale represents the number of pixels at each brightness value.
The Channel list lets you select a channel (Luminosity, Red, Green, Blue, RGB) for the
histogram.

The histogram changes to reflect adjustments in the Exposure setting in the DMC 2
main window and other controls in the Enhance window.

How to view a histogram.
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To view a histogram of brightness levels in the image:

1

If the DMC 2 main window is visible, click Histogram on the Tools menu.
If the Enhance window is visible, click the histogram button .

Select a channel for display from the Channel list (Luminosity, Red, Green, Blue,
RGB).

If necessary, adjust the Exposure slider in the main DMC 2 window or adjust the
controls in the Enhance window while viewing their effect on the histogram.
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Adjusting Sharpness

Drag the Sharpness slider left or right to decrease or increase sharpness.

The effect of your setting appears in the preview image to the left.
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Viewing the Full Image

If necessary, you can view the full image for close inspection after capturing but
before saving. When viewing the full image, you can zoom and pan to assure you have
captured the desired area and detail and that enhancements you applied have the
expected results.

To view the full image:

1 In the main DMC 2 window, click Capture & Enhance.
The captured image appears in the Enhance window.
2 Enhance the image as needed.
3 Click the full image button to display the image in the Full Image window.

4 Use the controls in the window to zoom, pan, print or save the image.
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Reducing Grain in Long Exposures

You can reduce image grain in long exposures (longer than 500 milliseconds) by
enabling the DMC 2 multi-frame averaging/dark subtract feature.

To enable or disable multi-frame averaging/dark subtract:

Click Set Preferences on the Tools menu.
Click the General tab.
Click the Multi-Frame Averaging/Dark Subtract box to enable or disable it.

A W N =

If you are enabling the feature, select the number of light frames and dark frames.
Higher light frame and dark frame values usually provide more grain reduction.

5 Click OK.
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Adding a Label

Macintosh Windows
1 Click the Add Text Label box. 1 Click the white Label strip below the
2 Type a label or other descriptive infor- ~ 1Mage
mation in the text box. 2 Type a label or other descriptive infor-
mation.

3 Select a font and a font size.

4 If necessary, click the Bold box to
change the font to bold.

This label appears at the bottom of the image when it is saved, transferred to another
application, or printed.
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Adding a Calibrated Micron Marker

DMC 2 software can add a calibrated scale or micron marker to the lower right corner
of your image, providing an accurate tool for determining dimensions of features in
the image.

To add a micron marker to the image:

1 If you have not already done so, create a calibrated micron marker for the micro-
scope objective you are using.
Creating a calibrated micron marker
Click the Add Micron Marker box.

Choose the marker appropriate for the microscope objective from the box that
appears next to the Add Micron Marker box.
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Creating a Calibrated Micron Marker

To create a calibrated micron marker you can add to the bottom of images for deter-
mining dimensions of features in the image:

Macintosh Windows

1 Place a micrometer horizontally 1 Select Calibrate Objectives from the
under the microscope objective and Tools menu.
focus the microscope to obtain a The Calibrate Objectives Tips box

sharp image of the scale in the DMC 2
main window.

2 Click the Add Micron Marker box.

opens.

2 Place a micrometer horizontally
under the microscope objective and

3 Click the popup menu next to Add focus the microscope to obtain a
Micron Marker box and select Cali- sharp image of the scale in the DMC 2
brate Objective. main window.
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Creating a Calibrated Micron Marker (continued)

Macintosh Windows

The Micron Marker Calibration win- 3 In the Calibrate Objectives Tips box,
dow opens and displays the microme- click the Snap button.

ter image. The Calibrate Objective window opens

4 Define a measured distance on the and displays the micrometer image
micrometer image by dragging a line
from one micrometer scale mark to

4 Define a measured distance in the
image by clicking on one micrometer

another. mark, then clicking on a second
The measured distance appears as a micrometer mark.

green line. Tc? correct the distance, An “x” appears at each point you
draw a new line. click

5 Type the distance represented by the
line in the Distance box.
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Creating a Calibrated Micron Marker (continued)

Macintosh Windows

6 Enter or select the units of measure in To remove the second mark, click the
the Units popup. Clear button. To remove the second

7 Type a name for the marker in the and the first marks, click the Clear
Marker Name box. button twice.

8 Click Save Marker. 6 Type the distance between the two

marks in the Distance box, and choose
the units of measure for the distance

(End of Macintosh procedure) from the Measurement Unit box.

7 Type a description for this objective
(30 characters, max.) in the objective
description box.
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Creating a Calibrated Micron Marker (continued)

Macintosh Windows

(no further steps for Macintosh systems) 8 If you want this calibrated marker to
be the default marker in the Enhance
window, click the Use as default
objective box.

9 Click OK.
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Deleting a Calibrated Micron Marker

If necessary, you can delete a calibrated micron marker from the list box located
below the Add micro marker box:

Click Add micron marker at the bottom of the Enhance window.

Click Delete Micron Marker from the list of micron markers.

In the Micron Marker box, click the name of the micron marker you want to
delete.

Click Delete.
To remove additional micron markers, repeat steps 3 and 4.

Click Close.
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Saving and Reusing Program Settings

If you develop settings in the Enhancement window that you expect to use frequently,
you can save them to a file, then reload them when necessary.

If necessary, see Program settings you can save.

To save the current program settings in the current settings file:

Macintosh Windows
1 In the Enhancement window, click In the Enhancement window, click Save
Settings. Settings on the File menu.

2 Select Save Settings.
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Saving and Reusing Program Settings (continued)

To save the current settings in a new settings file:

Macintosh Windows

1 In the Enhancement window, click 1 If the main DMC 2 window is open, click
Settings. Settings on the File menu to open the

2 Type a name for the new settings Settings window. Then click New to dis-
file. play the Add New Settings box.

3 Select Save. If the Enhance window is open, click
Save Settings As on the File menu to
display the Add New Settings box.

2 In the Settings Name box, type a
descriptive name for the new settings
you are saving.

3 Click OK.
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Saving and Reusing Program Settings (continued)

To load enhancement settings you saved earlier:

Macintosh Windows
1 In the Enhancement window, click 1 In the main DMC 2 window, click
Settings. Settings on the File menu to display
2 Select the name of the settings to be the Settings window.
applied. 2 Click the name of the settings you
want to load.
3 Click OK.
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Saving and Reusing Program Settings (continued)

To delete a settings file:

Macintosh Windows
1 In the Enhancement window, click 1 In the main DMC 2 window, click
Settings. Settings on the File menu to display
2 Select the name of the settings to be the Settings window.
applied. 2 Click the name of the settings you
3 Click Delete. want to delete.
3 Click Delete.
4 Click OK.
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Program Settings You Can Save

When you save DMC 2 program settings for reuse (see Saving and Reusing Program
Settings), the following settings are saved.

Main DMC Window Settings

+ Color checkbox state + Color Temperature
+ Exposure + Image Type
+ Sensitivity + Image Size

Enhance Window Settings

* Red * Brightness
* Green * Gamma
* Blue « Sharpness

« Dark Levels
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Program Settings You Can Save (Continued)

Preferences Box -- General Settings

* On each image capture « Overwrite images during Rapid Fire
+ Cast found on color balance « Number of Light Frames

+ Show preview on startup « Number of Dark Frames

+ Use flash + Launch External Application

« Save Viewfinder ROI settings on exit- + External Application Path
ing the application

Note: The state of the Multi-Frame Averaging/Dark Subtract checkbox and the num-
ber of dark and light frames are not saved.
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Program Settings You Can Save (Continued)

Preferences Box --Remote Settings

+ Use Remote Capture

* Transfer to Enhance Window
* Transfer to Application

+ Save Directly to File

Preferences Box -- Output Settings

+ Highlight property (Specular or Non-
Specular)
* Color Channel Mixture

Preferences Box -- Cameras Settings

No Cameras settings are saved.

Remote Capture Files Folder
Remote Capture Files Base Name
Remote Capture Files Image Type

Color Output Scale
Grayscale Channel Mixture
Grayscale Output Scale
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Setting DMC 2 Software Preferences

The DMC 2 Preferences dialog box (Macintosh) and the Set Preferences dialog box
(Windows) let you choose these categories of settings for the DMC 2 software:

* General * Output

* Remote e Cameras

To display the Preferences box for viewing or changing preferences:

Macintosh Windows

Click the Preferences button in the Click Set Preferences on the Tools
main DMC 2 window. menu.
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General Preferences

Use the General tab to select general DMC 2 software operation preferences.

On each image capture:

Reset to defaults Resets all controls in the Enhance window (Color, Dark Lev-
els, Brightness, Gamma, Sharpness) to their factory-defaults after you capture
a picture.

Use existing settings Leaves all controls in the Enhance window unchanged
after you capture a picture.

Do auto color balance Automatically analyzes the image and sets the Dark
Levels and Brightness sliders in the Enhance window to their optimum values
each time you click the Capture & Enhance button or the Capture & Transfer
button in the Main window. Also sets the Enhance window color sliders to 0,
sets the Gamma slider to 50%, and applies the color cast setting selected under
"Cast found on auto color balance" (described below).

Next 72

Download from Www.Somanuals.com. All Manuals Search And Download.



General Preferences (Continued)

Cast found on auto color balance (available only if Do auto color balance is selected
under “On each image capture”):

Remove it Removes any overall color cast (tint) from the image when per-
forming auto color balance.

Keep it Retains any overall color cast in the image when performing auto color
balance.

Always ask If an overall color cast is detected during auto color balance, dis-
plays a dialog box for removing or keeping it.
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General Preferences (Continued)

Show preview on startup Expands the Main window to show a preview image when
the DMC 2 program starts.

Use flash Activates the x-sync flash cable connector on the DMC camera when the
image is captured. The default setting is off (disabled).

X-sync flash cable connector
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General Preferences (Continued)

Save Viewfinder ROI settings When the DMC 2 program is closed, saves the image
capture area (region of interest) selected on the Region of Interest Selection tab in the
DMC 2 main window.

Overwrite Images During Rapid Fire When camera buffer becomes full during a
rapid fire sequence, begins overwriting the first file in the buffer instead of stopping
rapid fire.

Multi-frame Averaging/Dark Subtract Enables multi-frame averaging and dark
frame subtract for reducing grain in long exposures (longer than 500 milliseconds).
After enabling this feature, select the number of light frames and dark frames. (Higher
values increase grain reduction.)
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General Preferences (Continued)

Launch External Application Starts the image-editing application specified in the
External Application Path box when an image is saved to disk. Displays the saved
image in the application.
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Remote Preferences

Use the Remote tab to capture images using the remote trigger. You can specify if you
want the captured images transferred to an image-editing program, the Enhance win-
dow, or to files.

Use Remote Capture Captures images using to remote trigger. Select if you want to
capture multiple images remotely.

Transfer to Enhance Window Captures images and automatically transfers them to
the Enhance window where you can manually adjust color balance, dark levels, or
brightness, gamma or sharpness.

Transfer to Application Capturesimages and automatically transfers the image to an
image editing program.
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Remote Preferences (Continued)

Save Directly to a File Captures images and saves them directly to a file for viewing
and enhancing at a later date.

Remote Capture Files:

Change Allows you to specify a location for your image files if you select Save
Directly to a File. Also allows you to select the file format (TIFF, BMP or JPEG)
and the base name of the saved files.
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Output Preferences

Use the Output tab to select the highlight property and the output defaults of the
images.

Highlight Property:

Specular Usually provides best image results with reflected-light microscopy
specimens containing specular highlights (reflective or metallic areas or points
much brighter than most of the image).

Non-specular Usually provides best results for reflected-light microscopy
without specular highlights and for all transmitted-light microscopy.
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Output Preferences (Continued)

Output Defaults:
For best results, choose the appropriate channel mixture and output scale for your
specimen and the way the image will be used.

Color Channel Mixture

CRT color Optimizes the output image color for display on a monitor.
Identity Leaves the output image color as detected by the camera.

Portrait Optimizes the output image color for studio portrait photogra-
phy software programs.

Fluorescent Optimizes the output color for fluorescent microscopy soft-
ware programs.
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Output Preferences (Continued)

Color Channel Mixture (continued)

User Use the custom color channel mixture in MATRIX2PUSER.MTX (for
DMC 2 cameras) or MATRIXIEUSER.MTX (for DMC Ie cameras).

Color Output Scale

Tone Scale Optimizes the output image tone values for display on a
monitor.

Linear Sets the tone value of each output pixel in proportion to the
actual transmittance or reflectance measured by the camera.

Logarithmic Sets the tone value of each output pixel in proportion to the
logarithm of the actual transmittance or reflectance measured by the
camera.
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Output Preferences (Continued)

Grayscale Channel Mixture

The Grayscale Channel Mixture uses the following (RGB channels) to produce a
grayscale image:

Luminance Digitally provides the effect of a luminance filter for gray-
scale imaging.

Red Provides the effect of a red filter.
Green Provides the effect of a green filter.

Blue Provides the effect of a blue filter.
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Output Preferences (Continued)

Grayscale Channel Mixture (continued)

Cyan (DMC Ie cameras only) Provides the effect of a cyan filter.
Magenta (DMC Ie cameras only) Provides the effect of a magenta filter.

Yellow (DMC Ie cameras only) Provides the effect of a yellow filter.

Next 83

Download from Www.Somanuals.com. All Manuals Search And Download.



Output Preferences (Continued)

Grayscale Output Scale

Tone Scale Optimizes the output image tone values for display on a
monitor.

Linear Sets the tone value of each output pixel in proportion to the
actual transmittance or reflectance measured by the camera.

Logarithmic Sets the tone value of each output pixel in proportion to the
logarithm of the actual transmittance or reflectance measured by the
camera.
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Camera Preferences

Use the Select Camera tab to select the active DMC camera when multiple DMC cam-
eras are connected to the computer.

Cameras are identified by their Device IDs (SCSI addresses) and their Adapter IDs. To
select a camera, click the appropriate line in the window and then click OK.
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Using the Color Stacker Utility

The Color Stacker utility provided with DMC 2 software provides a way to combine
three images. This is useful when imaging a single sample with multiple fluoro-
chromes. Instead of viewing separate images, you can process the fluorochromes in
red, green and blue channels and view the result in a single composite image.

Creating a Composite Image

Macintosh Windows

1 Use the DMC 2 camera and softwareto 1 Use the DMC 2 camera and software to

capture and save an image for each of capture and save an image for each of

the three color channels. You must the three color channels. You must

save the images in the TIFF format. save the images in the TIFF format.
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Creating a Composite Image (Continued)

Macintosh

Windows

2 Open the Color Stacker utility (dou-
ble-click Polaroid Color Stacker).

3 Select an image for each color channel
by clicking each color button (Red,
Green and Blue) and selecting the
appropriate TIFF file.

4 Click Create Composite, select a
folder and file name, and save the
composite image.

2 Open the Color Stacker utility (click
the Windows Start button, point to
Polaroid Digital Microscope Camera
2 on the Programs menu, and click
Polaroid Color Stacker).

3 Select an image for each color channel
by clicking each color button (Red,
Green and Blue) and selecting the
appropriate TIFF file.

4 Click Create Composite, select a
folder and file name, and save the
composite image.
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Color Stacker Preview Options

The Color Stacker utility displays a preview of the composite image as you select files
for each color channel. By clicking the Options button at the top of the Color Stacker
window, you can select from one of these composite preview options:

+ Show Original Image
« Show Relevant Channel

* Add Channel Progressively
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Camera Maintenance

DMC 2 camera maintenance consists of cleaning the camera when necessary.

Click on either topic below for more information.
Cleaning the camera optics

Cleaning the camera body
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Cleaning the Camera Optics

Important: Protect the DMC 2 camera from dirt, dust, rain and moisture. Damage
caused by these conditions may not be covered by the warranty. Always protect the
shutter, the anti-aliasing filter (behind the shutter), and the CCD sensor by placing the
cap on the camera c-mount opening whenever the camera is removed from the micro-
scope. This will also minimize the need to clean the camera optics.

Caution: The DMC 2 camera is a precision optical instrument. Carefully follow the
instructions in this section when you clean it. Failure to do so could damage the shut-
ter or the anti-aliasing filter and void your warranty.
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Cleaning the Camera Optics (Continued)

Verifying the Location of Dust or Dirt

Avoid needless cleaning of the DMC 2 camera optics by determining the location of
dust or dirt before proceeding. You can determine whether the dust or dirt is in the
camera optics or the microscope optics by comparing two images as follows:

1 Take a picture with the camera in its normal position.

2 Rotate the camera 30 or 40 degrees, and take a second picture of the same speci-
men.

If the spot moves in relation to other elements in the picture, it is caused by dust
on the camera anti-aliasing filter or the c-mount adapter lens. In this case, skip to
step 3 to determine the location.

If the dust remains in the same location relative to other elements in the picture, it
is caused by dust on the microscope optics. Discontinue this procedure and refer
to the cleaning instructions provided with your microscope.
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Cleaning the Camera Optics (Continued)

3 Follow these steps to determine whether the dust spot is on the camera optics or
the c-mount adapter lens:

b

Next

Separate the camera from the c-mount.
Install the lens cap on the DMC 2 camera.
Clean the c-mount adapter lens according to the manufacturer’s instructions.

Reattach the c-mount and the DMC 2 camera to the microscope and take a pic-
ture.

If the spot remains in the image, follow the camera optics cleaning steps.

If the spot is no longer visible, discontinue this procedure.
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Cleaning the Camera Optics (Continued)

Camera Optics Cleaning Steps

1 If you have not already done so, install the shutter-opening software on your com-
puter as follows. (This software opens the shutter, allowing you to clean the cam-
era optics.)

Macintosh Windows

a Copy the file DMC 2 SHUTTER No special installation is necessary.
OPENER INSTALLER from the DMC (The shutter-opening software is
2 CD (provided with the camera) to installed during DMC 2 software
the desktop. installation.)

b Double-click DMC 2 Shutter
Opener Installer.

¢ Follow instructions on the screen.
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Cleaning the Camera Optics (Continued)

2 Obtain the following cleaning materials:

+ Clean camel-hair brush (small) + Lint-free disposable cleaning wipe
(such as e-wipe) or a high-grade lens

+ Can of clean-room-grade com- : ' )
tissue (non-abrasive and lint-free)

pressed air

- Bulb-type manual blower + Distilled water or methanol

3 Detach the camera from the microscope, and remove the c-mount adapter from
the camera. If you are using the camera with a lens, remove the lens.

4 If the camera is not connected to the computer, turn off the camera and the com-
puter. Then connect the camera to the computer.

5 Turn on the camera, then turn on the computer and wait for it to start.
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Cleaning the Camera Optics (Continued)

6 Run the shutter-opening software:

Macintosh Windows
a Double-click DMC 2 Shutter a Select Programs from the Windows
Opener. Start menu.
b Click Open DMC 2 Shutter. b Point to Polaroid Digital Micro-
¢ Click OK. scope Camera 2 and select Shutter
Cleaning Tool.

7 Power down the computer and turn the camera power off. (The shutter remains
open.)
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Cleaning the Camera Optics (Continued)

8 Clean the anti-aliasing filter (behind the shutter) with air. If necessary, gently dis-
lodge any dust with the camel-hair brush.

Caution: Use care when inserting anything into the camera lens opening. The
shutter blades and filter are easily damaged. If using canned air, be sure to hold
the can upright to avoid spraying liquid propellant into the camera. Also avoid
spraying canned air directly at the shutter.

9 If the filter is clean, skip to step 10.
If dust or dirt remains after you use the air and the brush, follow these steps:
a Moisten a lint-free wipe with distilled water or methanol.
b Lightly wipe across the surface of the filter in a single direction only.

Note: Do not go over a previously wiped area with the same wipe, and do not
reuse a wipe. Dirt collected on the wipe can damage the filter.
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Cleaning the Camera Optics (Continued)

¢ If dust or dirt remains after the first attempt to wipe it away, repeat the proce-
dure with a new, clean wipe.

10 After the filter is clean, close the shutter by turning the camera power switch on
and then off.

11 Reattach the camera to the microscope.
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Cleaning the Camera Body

If the DMC 2 camera body requires cleaning, use a clean, soft cloth dampened with
water.

Do not use cleaners of any kind, and do not spray water or other liquids directly
onto the camera.
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Obtaining Software Updates

For the latest information about DMC 2 software updates, visit the Polaroid Web site:

www.polaroid.com
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DMC 2 Camera Specifications

Sensor

Output resolution

Image formats

Image transfer speed
Computer interface

Weight

Next

2.1 megapixel, 11mm CCD

Super high resolution (1600x1200 pixels)
High resolution (800x600)
Normal resolution (400x300 pixels); Windows version only

48-bit color (68.7 billion colors)
24-bit color (16 million colors)
16-bit grayscale (65,000 gray shades)
8-bit grayscale (256 gray shades)

Greater than 2 MB/second SCSI data transfer
SCSI-2
2.11b (963g)
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DMC 2 Camera Specifications (Continued)

Dimensions 2.1x7.2x5.1 in (5.3x18.3x13.0cm)
Power supply 100-250V, 0.38A, 50-60Hz surge-protected input
+6 VDC, 2.0A output

Safety approvals SA, CE, DVE

Limited warranty 1 year, parts and labor

Note: Specifications subject to change without notice.
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System Requirements

Using the DMC 2 camera and software to preview, capture and enhance pictures
requires a minimum level of computer hardware and software. If your system does
not meet these requirements, contact your Polaroid dealer or your computer dealer.

PC system requirements

Macintosh system requirements
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PC Minimum System Requirements

+ 166 MHz Pentium processor and 64 megabytes (MB) of RAM. (96MB of RAM for a
TWAIN-compliant image processing program such as Adobe Photoshop or Image-
Pro.)

* Microsoft Windows 95, 98, Me, 2000 or NT (4.0 or later) operating system.
+ ASPI-compliant SCSI adapter and the appropriate Windows drivers.
* 24-bit color display adapter.

+ Light microscope with a .63x, 1:1, or larger C-mount adapter
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Macintosh Minimum System Requirements

PowerPC Macintosh computer or compatible with a SCSI-2 interface and 64 mega-
bytes (MB) of RAM. (96MB of RAM for a Photoshop-Plug-In-compliant image pro-
cessing program such as Adobe Photoshop or Image-Pro.)

Apple system software version 8.6 or later.

QuickTime software, version 4.0.3 or later.

80MB of available hard disk space.

24-bit color display adapter.

Light microscope with a .63x, 1:1, or larger C-mount adapter
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Installing Software and Setting Up the Camera

1
2
3
4
5
6

Unpack.

Install the DMC 2 software.

Attach the camera to the microscope.
Connect the camera to the computer.

Connect the camera to AC power and turn on.

Take a test picture.
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Unpacking

Make sure you have all the following components. Contact your dealer if any is miss-
ing or damaged.

1 DMC 2 camera

2 power supply and cord (may differ from illustration for
some locations)

3 SCSI host adapter installation kit for PCs (optional; con-
tact your dealer)

4 SCSI cable adapter (HD50 to DB25)
5 SCSI cable (2-meter)

6 Polaroid DMC 2 Software CD with: TWAIN driver and
Polaroid DMC 2 software for Windows 95, 98, Me, 2000
and NT; Adobe Photoshop plug-in and Polaroid DMC 2
software for Macintosh systems; online user’s guide

7 Optional image-reporting software (available in some
regions)
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Installing the DMC 2 Software

Turn the computer on.

2 On Windows systems, close any applications that may be running.
3 Insert the Polaroid DMC 2 software CD into the drive.
4 Start the installation program:
Macintosh Windows
Double-click the Polaroid DMC 2 Wait for the DMC 2 install program to
Installer. start.
If it does not, select Run from the
Windows Start menu. Click Browse
and select SETUP.EXE on the CD-
ROM. Click OK.
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5 Follow instructions on the screen.

6 Remove the CD from the drive.

Attaching the Camera to the Microscope

You need a 0.63 or 1:1 c-mount adapter (not provided) compatible with your micro-
scope. (Do not use a 0.5 c-mount adapter.) Refer to your microscope manual for more
information about c-mounts.

Caution: Verify that the threaded end of the c-mount adapter does not exceed 0.25 in.
(6.3mm). Longer adapters can damage the camera.

0.25in.
L_,I (6.3mm)
maximum
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To attach the camera to the microscope:

1 Screw the c-mount adapter into the camera.
Note: Finger-tighten the adapter. Do not use tools.

2 Insert the c-mount adapter into the microscope. The camera indicator LEDs
should face the front of the microscope.

Indicator
LEDs
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Connecting the Camera to the Computer

The DMC 2 camera requires a SCSI host adapter in your computer. If your computer
does not have an adapter, you must install one (see Installing a SCSI Host Adapter).

If your computer is a PC-compatible with a SCSI adapter, but the adapter is connected
to a hard drive, installing a second adapter is recommended.
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Setting the Camera SCSI Address

Each device connected to a SCSI host adapter must have a unique address from 0-6. To
assure a unique address for the camera, determine the addresses of any other SCSI

devices:

Macintosh

Windows

1 Run Apple System Profiles, usually on  Look at the SCSI address switch on each
the Apple menu. If it is not, it may be ~ SCSI device connected to your system. If
available from www.apple.com/ necessary, see the instructions provided

swupdates.

with the devices.

2 Click Devices and Volumes to view
the SCSI device addresses.

Next
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Setting the Camera SCSI Address (Continued)

Turn the camera power switch to off (0) and set the SCSI address switch to a value not
used by any other device.

/

-

2|

A

O ——

SCSI address switch

Do notuse?7,80r9
(not valid addresses)

O —

Ho

Power switch

\ (off =0)

[
i
\\

Note: The address is preset to 4. Do not change it unless another device is using 4.
Other addresses typically available are 2, 5 and 6.
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Connecting the SCSI Cables

Place the DMC 2 camera at the end of the SCSI chain as shown or between the com-
puter and other SCSI devices. Use the shortest possible cables.

Note: Turn the computer, camera and all other SCSI devices off before connecting or
disconnecting any cables. Do not connect the camera to the parallel connector on
your computer. Doing so could damage the camera or computer.

DMC camera
termination on (1)

Computer ]

...........

Other SCSI device
(not terminated)
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Setting Termination

The last device in a SCSI chain must be terminated (or have termination on), while all
other devices must be unterminated (or have termination off).

If the camera is the only SCSI device connected to your computer or the last device in
a SCSI chain, set camera termination to on (1). Otherwise, set termination to off (0).
Termination instructions for your other SCSI devices are provided with the devices

Note: Do not use an external, passive terminator to terminate the camera. If another
device is at the end of the SCSI chain, that device must be terminated with an active
terminator for proper camera operation.

Termination switch
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Connecting the Camera to AC Power and Turning On

1 Connect the camera to AC power and turn the power switch on.

To AC power

Power switch (on=1)

2 Verify that the green and yellow LEDs are on, indicating AC and termination
power are on.

Green LED
Yellow LED
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3 Turn the computer on.

4 Wait for the system to install the camera driver and display the normal desktop.

Next 116

Download from Www.Somanuals.com. All Manuals Search And Download.



Taking a Test Picture
1 Start the DMC 2 program:

Macintosh Windows
Double-click Polaroid DMC 2. 1 Select Programs from the Start
menu.

2 Point to Polaroid Digital Micro-
scope Camera 2 and select
Polaroid DMC 2.

2 Place a specimen under the microscope and focus it through the microscope eye-
piece.

3 Click Preview in the DMC 2 main window. If necessary, adjust the c-mount on the
microscope to focus the image on the computer screen. (Refer to your microscope
manual for instructions.)
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4 In the DMC 2 main window, choose the appropriate settings for the image being
captured:

Exposure

Sensitivity

Color Temperature
Select 8-Bit Color from the Image Type box for the test.
Click Capture & Save to capture and save the image to disk.

Open the saved image with an image-analysis application and verify that it was
captured satisfactorily.

Note: The color balance of this test image may not be satisfactory because of vari-
ations in light source color temperatures. You can correct this problem by creating
and using a custom color temperature setting. See Creating a Custom Color Tem-
perature.
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Camera Limited Warranty

Polaroid Corporation warrants the DMC 2 camera against defects in manufacture or work-
manship for a period of one year from the date of purchase. To verify the warranty period, you
should keep the invoice, sales receipt, or other proof of the purchase date.

Should this product or any component or accessory included with it, with the exception of
software, prove to be defective at any time during the warranty period, Polaroid Corporation
will, at its discretion, either replace or repair this item, without charge.

This warranty does not cover damage caused by accident, incorrect installation, unauthorized
modification, and misuse or abuse. A charge will be made for repair of such damage.

This warranty excludes all consequential damages. Some jurisdictions do not allow the
exclusion or limitation of consequential damages, so the foregoing exclusion may not

apply to you.
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Radio and Television Interference
FCC Notice (U.S.A.)

Note: This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installa-
tion. This equipment generates, uses and can radiate radio frequency energy and, if
not installed and used in accordance with the instructions, may cause harmful inter-
ference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful inter-
ference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one
or more of the following measures:

* Reorient/relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.
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FCC Notice (continued)

+ Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced radio/TV technician for help.

Note: If your camera SCSI cable has a ferrite core on one end, that end must be con-
nected to the camera.

FCC Caution: To assure continued compliance, any changes or modifications not
expressly approved by the party responsible for compliance could void the user’s
authority to operate the equipment.

Product: The Polaroid DMC 2 Microscope Camera

Marketed by: Polaroid Corporation, Cambridge, MA 02139 U.S.A. Telephone: 1-800-
432-5355
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FCC Notice (continued)

This device complies with Part 15 of the FCC Rules. Operation is subject to the follow-
ing two considerations: (1) This device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.

EMI Notice (Canada)
This equipment is a Class A digital apparatus which complies with the Radio Interfer-
ence Regulations, C108.8 - M1983.

Cet équipment est un appareil numérique de la classe A qui se conforme aux Regle-
ments sur la brouillage radioélectrique, C108.8 - M1983.
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Notice (Europe)

Warning: This is a Class A product. In a domestic environment this product may
cause radio interference in which case the user may be required to take adequate mea-
sures.

Polaroid Corporation certifies that this product conforms to the following standards:

Low Voltage Directive 73/23/EEC/EN60950/IEC 950
EMC directive 89/336/EEC

EN 55022

EN 50082-1

IEC 1000-4-2/EN 61000-4-2

IEC 1000-4-3/EN 61000-4-3

IEC 1000-4-4/EN 61000-4-4.
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Copyright and Trademark Notices

© Copyright 2001 Polaroid Corporation, Cambridge, MA 02139 USA.

“Polaroid” is a registered trademark Polaroid Corporation. All other product names
may be trademarks of their respective owners.

All rights reserved.
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Polaroid Offices and Service Centers

Australia Espaia

Polaroid Australia Pty. Ltd. Polaroid (Espaia). S. A.
13-15 Lyonpark Road Calle Orense 16 -2? planta.
P. 0. Box 163 28020-Madrid

North Ryde, NSW 2113 Tno.: 913778103

Tel.: (02) 950 7000
Fax: (02) 887 2209

Belgique/Belgié France

Polaroid (Belgium) N. V. - S. A. Polaroid (France) S. A.
Rue Colonel Bourg 111 B.P.7

Kolonel Bourgstraat 111 78996-Elancourt Cédex
1140 Bruxelles-1140 Brussel Tel.: 0141913810

Tel.: 027143102 (Flemish)
Tel.: 027143106 (French)
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Brasil Hong Kong

Polaroid do Brasil Ltda. Polaroid (Far East) Ltd.
Av. Paulista, 1776/11° andar 32/F Windsor House
Cerqueira Cesar 311 Gloucester Road
Sao Paulo - Capital Causeway Bay
01310-921 Tel.: (852) 2894 0333

Tel.: 55.11.285.6411
Fax: 55.11.283.2625
Fax: 55.11.288.6521
Fax: 55.11.287.5393

Canada Ireland
Polaroid Canada Inc. Tel.: 014026897
250 Carlingview Drive

Etobicoke, Ontario MOW 5G6

Toll free: 1-800-268-6970

Next
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Danmark
Polaroid a. s.
Blokken 75
3460 Birkered
TIlf.: 80011887

Deutschland

Polaroid GmbH

Sprendlinger Landstrasse 109
63069 Offenbach

Tel.: 06995096056

Next

Italia

Polaroid (Italia) S. p. A.
Via Piave 11

21051 Arcisate (Varese)
Tel.: 0269633253

Japan

Nippon Polaroid
Kabushiki Kaisha

Mori Building, No. 30
2-2 Toranomon 3-chome
Minato-ku, Tokyo (105)
Tel.: 81-3-3438-8811

Fax: 81-3-3433-3537
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Nederland

Polaroid Nederland B. V.
Zonnebaan 45

3606 CH Maarssen

P. 0. Box 1219

3600 BE Maarssen

Tel.: 0204874534

New Zealand

Polaroid New Zealand Ltd.

Camera Services
24-26 Anzac Avenue
Auckland

Tel.: (09) 377 3773

Next

Luxembourg
Tel.: 08002542

México

Polaroid de México S. A. de C. V.
Paseo de la Reforma 195-Piso 17
C. P. 06500 México, D. F.

Tel.: 703-1111

Fax: 566-0505

Del interior al 91 (800) 70-727
Ventas 91 (800) 70-747
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Norge

Polaroid (Norge) A/S
Industriveien 8B, 1473 Skarer
Postboks 80, 1471 Skarer

TIlf.: 80011887

Osterreich

Polaroid Ges. m. b. H.
Eitnergasse 5A

1231 Wein

Tel.: 06607433

Next

Schweiz/Suisse/Svizzera
Polaroid AG

Hardturmstrasse 133
8037 Ziirich

Tel.: 018385329 (Deutsch)
Tel.: 018385348 (Frangais)
Tel.: 018385349 (Italiano)

Suomi

Polaroid Oy
Sinikalliontie 10
02630 Esposo
Puh.: 0800117008
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Portugal

Polaroid (Espafa) S. A.
Sucursal em Portugal
Edificio Monumental

Avenue Praia da Vitdria 71-A, 4°B
1050 Lisboa
Tel.: 0505446017

Puerto Rico

Polaroid Caribbean Corporation
Centro de Seguros

Ave. Ponce de Ledén 701,
Miramar, Santurce 00907

Tel.: (809) 725-6240

Fax: (809) 725-5462

Next

Sverige

Polaroid AB
Ekholmsvidgen 36
Box 204

127 27 Skdrholmen
Tel.: 084451231

U. K.

Polaroid (U. K.) Ltd. &
Polaroid Export Operations
Wheathampstead House
Codicote Road
Wheathampstead
Hertfordshire AL4 8SF

Tel.: 0181 308 6508 (U. K.)
(44) 181 308 6593 (Export)
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U. S. A.

Polaroid Corporation
Technical Support

Toll free: 1-800-432-5355
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Technical Support

If you need additional help with your Polaroid equipment, call your nearest Polaroid
office at the number listed in Polaroid Offices and Service Centers. Polaroid offers a
variety of customer support services. Call for details and applicable fees.

You may also write to:

Digital Imaging Technical Support
201 Burlington Road, 1-2A
Bedford, MA 01730

Internet Support

Technical support is also available over the Internet. Connect to the Polaroid Web site
at www.polaroid.com.

Application Support

If you need help with your application software, please contact the manufacturer of
the software.
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Solving SCSI Communication Problems

SCSI device not recognized
Horizontal lines, sections missing from image

System stops responding during image transfer
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Problem: Device not recognized

Failure of your computer to recognize a SCSI device could be caused by any of the fol-
lowing:

Device not turned on. Turn the power switch on. (See instructions for turning the
device on.)

Cables loose or disconnected. Check all cable connections. (See instructions for
connecting the SCSI cables.)

Device turned on after computer. Make sure the device is turned on, then restart
the computer.

Incorrect SCSI address. Make sure the device has a unique SCSI address. (See
instructions for setting the SCSI address of the device.)
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Device not recognized (continued)

Incorrect termination. Check for proper SCSI chain termination. (See instructions
for setting termination.)

Outdated miniport and ASPI layer drivers (Windows systems only). Update the
SCSI host adapter Windows miniport driver (.MPD) files for your SCSI host adapter
according to instructions provided with the adapter. (For Windows NT, miniport
drivers have the extension .SYS.) Also make sure your system has the latest ASPI-
layer files in the WINDOWS/SYSTEMS folder. Updated drivers are often available
from your adapter manufacturer’s site on the World Wide Web.

DOS drivers in CONFIG.SYS (Windows systems only). Edit the CONFIG.SYS file to
disable any SCSI drivers. (Add REM to beginning of any SCSI driver lines).

Incompatible SCSI host adapter. Install an additional or different SCSI host
adapter. (The adapter must be ASPI-compliant.)
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Symptom: Horizontal lines, sections missing from image

If your images display horizontal lines or bands, check the following:

Incorrect termination. Check for proper SCSI chain termination. (See instructions
for setting termination.)

Low-quality cables. Use only high-quality SCSI cables.

Cables are too long. Use shorter SCSI cables. Standard SCSI chains are limited to a
total length of 6 meters. Fast SCSI chains are limited to 3 meters.

Faulty device (termination power fuse). Return device for service (see technical

support.)
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Symptom: System stops responding during image transfer

If your system locks and stops responding to the mouse and keyboard during image
transfer, check the following:

Incorrect maximum sync transfer rate or other settings (for Adaptec 2940 and
3940 host adapters only). Change the maximum sync transfer rate to its lowest set-
ting (5.0 or 10.0, depending on the adapter model). See Changing Sync Transfer Rate
on Some Adaptec SCSI Adapters.

Device on same SCSI bus with hard drive or CD-ROM drive. Install a second SCSI
host adapter for connecting the device. (See Installing a SCSI Host Adapter.)
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Changing Sync Transfer Rate on Some Adaptec SCSI Adapters

If your system has an Adaptec 2940 or 3940 SCSI host adapter, it may not recognize a
SCSI device if the minimum sync transfer rate or other values are incorrectly set.

To change the minimum sync transfer rate and other important values for these SCSI
adapters:

1 Restart your computer and wait for the following message to appear:

Press <Crtl><A> for SCSISelect (TM) Utility!

2 Immediately press the Control key and A to display the SCSISelect menu.
3 Select Configure/View Host Adapter Settings.
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Make sure the SCSI Device Settings are as follows:

Setting Optimum Value

Initiate Sync Negotiation No

Maximum Sync Transfer Rate ~ Minimum (5.0 or 10.0)
Enable Disconnection No

Initiate Wide Negotiation No

Note: Change these settings only for the SCSI address of the device not recognized.
Leave all other settings unchanged.

Press Esc until you are prompted to save the changes.

Select Yes, then press the space bar to restart the computer.
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Installing a SCSI Host Adapter

This device connects to a SCSI host adapter in your computer. Most Macintosh com-
puters have a SCSI adapter built in, but most IBM PC compatible computers do not.

If you must install a SCSI adapter, turn the computer off and follow instructions pro-
vided by the adapter manufacturer. (The procedure usually includes software installa-
tion. If your PC uses the Windows NT operating system, log in as an administrator
before installation.)

Note: A SCSI host adapter may have been provided as an option with your hardware
device. If necessary, obtain an adapter from your computer dealer. (Adapters are not
available for iMac computers.)
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Index

A

AC power, connecting camera to 115
area of interest, choosing 17
attaching camera to microscope 108

B
blackpoint, adjusting color balance by selecting 47
brightness, adjusting manually 50

C

camera body, cleaning 98

camera optics, cleaning 90

camera preferences 85

camera, attaching to microscope 108
camera, connecting to computer 110

Next
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Index (Continued)

camera, DMC, selecting 15

camera, selecting 14

camera, turning on 13

capture area, choosing 17

capturing the image 33

Cast found on auto color balance 73

color balance, adjusting automatically 44

color balance, adjusting by selecting gray point 46
color balance, adjusting by selecting whitepoint 45
color balance, adjusting manually 48

color balance, adusting by selecting blackpoint 47
Color Channel Mixture 80

Color Output Scale 81

color preview, choosing 19

color stacker utility, using 86

color temperature, custom, creating 27
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Index (Continued)

color temperature, setting 26
communication problems, SCSI, solving 133
copyright notice 124

D

dark levels, adjusting manually 49

dark subtract, using to reduce grain 56
device not recognized, solving 134

DMC Ie cameras, software compatibility 10
Do auto color balance 72

E

EMI notice (Canada) 122

EMI notice (Europe) 123
enhancing the capture image 43
enlarging the preview 21
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Index (Continued)

exposure, automatic, calibrating 23
exposure, setting automatically 22
exposure, setting manually 24

F

FCC notice 120

features, DMC 2 camera 9

file sizes, based on type and image sizes 31
flash, using 74

fluorochromes, combining with Color Stacker utility 86
focus, verifying digitally 32

focusing and framing preview 16

frame, smaller, choosing for capture 17
framing and focusing preview 16

full image, viewing 55

Next

Download from Www.Somanuals.com. All Manuals Search And Download.

144



Index (Continued)

G

gamma, adjusting 51

grain, reducing in long exposures 56

gray point, selecting to adjust color balance 46
Grayscale Channel Mixture 82

Grayscale Output Scale 84

grayscale preview, choosing 19

H

Highlight Property 79
histogram, viewing 52
horizontal lines, solving 136
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Index (Continued)

1

image enhancement 43

image size in pixels, selecting 30

image type, selecting 29

installing software and setting up camera 105
interference, radio and TV 120

Internet, obtaining technical support via 132
ISO value, setting 25

L

label, adding to image 57
Launch External Application 76
launching DMC 2 software 14
lines, horizontal, solving 136
lockup, system, solving 137
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Index (Continued)

M

maintenance, camera 89

marker,calibrated, adding to image 58

micron marker, calibrated, adding 58

micron marker, calibrated, creating 59

micron marker, deleting 63

missing image sections, solving 136
multi-frame averaging, using to reduce grain 56
Multi-frame Averaging/Dark Subtract 75

N
navigating in this document 7
Non-specular 79
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Index (Continued)

(o)

offices and service centers, Polaroid 125
Output Defaults 80

output preferences 79

Overwrite Images During Rapid Fire 75

P
package contents 106

picture taking, general steps 12
picture-taking sequence, typical 12
power switch, camera, turning on 13
preferences, general 72

preferences, setting 71

preview, choosing color or grayscale 19
preview, framing and focusing 16
printing the image 42

Next

Download from Www.Somanuals.com. All Manuals Search And Download.

148



Index (Continued)

R

rapid fire feature, using 40

rapid sequence of images, capturing 40
Remote Capture Files 78

remote preferences 77

Reset to defaults 72

responding, system stops, solving 137
rotating the image 20

S

Save Directly to a File 78

Save Viewfinder ROI settings 75

scale, calibrated, adding to image 58

SCSI address, camera, setting 111

SCSI cables, connecting 113

SCSI communication problems, solving 133
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Index (Continued)

SCSI host adapter (SCSI card), installing 140
sections missing from image, solving 136
selecting a DMC 2 camera 15

sensitivity, setting 25

sequence of images, capturing 40
sequence, picture-taking 12

service centers and offices, Polaroid 125
settings, program, saved in settings file 68
settings, program, saving and reusing 64
sharpness, adjusting 54

Show preview on startup 74

size in pixels, image, selecting 30

software updates, obtaining 99

software, DMC 2, starting 14

software, installing 107

specifications, camera 100
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Index (Continued)

Specular 79

starting DMC 2 software 14

sync transfer rate, changing on SCSI adapters 138
system requirements 102

T
technical support, obtaining 132
termination, SCSI, setting 114
text label, adding to image 57
trademark notice 124

Transfer to Application 77
Transfer to Enhance Window 77
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Index (Continued)

U

updates, software 99
Use existing settings 72
Use flash 74

Use Remote Capture 77/

w

warranty, camera, limited 119

whitepoint, selecting to adjust color balance 45
World Wide Web, obtaining technical support via 132

z
zooming the preview 21
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